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Willkommen zu Global Mapper

Vielen Dank, dass Sie Global Mapper verwenden, die All-in-one-GIS-Anwendung von Blue Marble 
Geographics. Wie Sie bald feststellen werden, bietet diese einzigartige Software eine umfangreiche 
Sammlung von Werkzeugen zur Geodatenverarbeitung in einer einfach zu bedienenden Anwendung, die 
kein GIS-Profi oder Kartenenthusiast missen sollte.

Wenn Sie beginnen, die Fülle an Features und Funktionen von Global Mapper zu erkunden, werden Sie 
feststellen, dass dies ein wirklich bemerkenswertes Software-Tool ist. Nirgendwo sonst finden Sie eine 
Anwendung, die Dateiformatunterstützung, Datenvisualisierungsoptionen, Digitalisierungsfunktionen, 
Tools zur räumlichen Analyse, LIDAR- und 3D-Analysefunktionen sowie Kartendesign-Tools direkt in einer 
Applikation vereint und unmittelbar nach der Installation bereitstellt.

Bei Blue Marble Geographics setzen wir uns dafür ein, dass unsere Kunden mit den Informationen und 
Ressourcen versorgt werden, die sie für eine effektive Nutzung der erworbenen Software benötigen. 
Zu diesem Zweck bieten wir Ihnen gerne eine Sammlung von Lehrmaterialien an, die Ihnen helfen, im 
Handumdrehen loszulegen.

Dieses Handbuch »Erste Schritte« soll Ihnen bei der grundlegenden Bedienung von Global Mapper helfen 
und Sie dabei unterstützen, einige der häufig verwendeten Optionen und Funktionen zu verstehen. Um 
eine vollständige Anleitung zu allen Funktionen der Software zu erhalten, wählen Sie im Menü Hilfe die 
Option Hilfe… oder klicken Sie auf die Taste F1 auf Ihrer Tastatur. Wenn eine formelle Einweisung oder ein 
Selbsttraining erforderlich ist, besuchen Sie https://www.globalmapper.de/training/, um sich über derzeit 
verfügbare Programme und Ressourcen zu informieren.
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1 Installation und Registrierung

Installation von Global Mapper
Die aktuelle Version des Global Mapper können Sie von der folgenden Webseite laden:

http://www.bluemarblegeo.com/global-mapper-download 

Wählen Sie das Installationsprogramm von Global Mapper und laden es. Die deutsche Version finden Sie unter 
»Alternate Languages«.

Die 64-Bit-Version ist der Standard-Download. Sie nutzt den verfügbaren zusätzlichen Speicher voll aus und ver-
bessert die Leistung der Software. Um Global Mapper zu installieren, doppelklicken Sie einfach auf die ausführbare 
Datei. Die Dateiinstallation dauert nicht länger als ein paar Minuten.

Global Mapper registrieren
Wenn Sie Global Mapper das erste Mal starten, sehen Sie das Fenster Register Global Mapper. Die Option, die Sie 
auswählen, bestimmt das Maß an Funktionalität, das Ihnen zur Verfügung steht.

Melden Sie sich mit einem Blue Marble Geographics-Konto an, um eine Testlizenz anzufordern oder eine 
Einzelbenutzerlizenz aus einem kürzlich erworbenen Kauf zu aktivieren (erfordert eine Bestellnummer). Verwenden 
Sie den Link Login verwalten, um ein neues Konto zu erstellen oder ein verlorenes Passwort wiederherzustellen.

Offline-Aktivierung
Aktivieren Sie die Software mit einer Lizenzdatei, die Sie per E-Mail erhalten haben. Hier werden auch die 
Informationen des Computers angezeigt, die an uns oder direkt an authorize@bluemarblegeo.com gesendet wer-
den können, um eine Lizenz für einen Offline-Computer anzufordern.

Verbinden mit einem Netzwerklizenzserver
Wenn Ihr Unternehmen oder Ihre Organisation ein Netzwerklizenzierungssystem eingerichtet hat, können Sie diese 
Option verwenden, um eine Lizenz auszuchecken, während Sie die Software verwenden. Wenn Sie die Lizenz nicht 
mehr benötigen, kann sie zurückgegeben und von einer anderen Person in Ihrer Organisation verwendet werden.

Weiter ohne Registrierung
Eine unregistrierte Version von Global Mapper bietet eingeschränkte Funktionalität (keine Unterstützung beim 
Speichern oder Laden von Arbeitsbereichen, keine Exportoptionen, kein 3D-Viewer usw.) und ist nicht für die 
Datenverwaltung oder Produktion gedacht.

Aktivieren optionaler Erweiterungen
Nach der Registrierung von Global Mapper haben Sie die Möglichkeit, die Funktionalität der Software mit Add-On-
Lizenzen zu erweitern. Um zusätzliche Funktionen freizuschalten, müssen Sie die entsprechende Lizenz erwerben – 
das betrifft auch Global Mapper Pro. 

Erweiterungen werden normalerweise von Drittentwicklern entwickelt und registriert, jedoch wird eine vorkonfigu-
rierte Erweiterung namens COAST-Erweiterung mit Global Mapper installiert. Dieses leistungsstarke Instrument wird 
verwendet, um die finanziellen Auswirkungen von Küstenüberschwemmungen zu analysieren.

Dokumentation zur Lizenzierung
Ausführliche Hinweise zum Download und zur Lizenzierung finden Sie in einer umfangreichen Dokumentation, die 
Sie hier laden können:

http://www.mapshop-online.de/download/Lizenzierung_Global_Mapper.pdf
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2 Navigieren in der Oberfläche
 
Die Global Mapper-Benutzeroberfläche dient dem einfachen und intuitiven Zugriff auf alle Eigenschaften und 
Funktionen der Software. Die wichtigsten Elemente der Benutzeroberfläche sind die Menüs, die Werkzeugleiste und 
natürlich das Kartenfenster selbst. Eine Vielzahl von Dialogfeldern und freien Fenstern bieten Zugriff auf zusätzliche 
Werkzeuge oder erweiterte Funktionalitäten.

Die Titelleiste zeigt Informationen über die Version des Global Mapper und den Namen des Arbeitsbereichs. 
Menüs ermöglichen den Zugriff auf die meisten Global Mapper Kernfunktionalitäten. 

Die Werkzeugleiste bietet eine bequeme Möglichkeit, um ein Werkzeug auszuwählen,  
       eine bestimmte Funktion anzuwenden oder eine Einstellung zu ändern.

Die Favoritenliste bietet einen einfachen Zugriff auf häufig verwendete Werkzeuge. 

Der Maßstabsbalken und andere Anzeige-Funktionen wer-
den über die Arbeitsbereich-Layout-Funktion verwaltet.

Das Kontrollcenter listet alle geladene Ebenen auf und 
ermöglicht, bestimmte Einstellungen auf diese Ebenen 
anzuwenden. Eine Reihe von Button bietet schnellen 
Zugriff auf ausgewählte Funktionen.

Statusleiste: Informationen zu einem 
ausgewählten Element (linker Bereich); 
Maßstab und Koordinaten des Cursors 
(rechter Bereich)

Das Digitalisier-Rechtsklick-Menü bietet eine 
umfangreiche Sammlung von Werkzeugen zum 
Erstellen oder Bearbeiten von Elementen auf 
der Karte.
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2.1 Menüs
Die Menüs in Global Mapper sind intuitiv nach Funktion organisiert und bieten Zugriff auf alle Eigenschaften und 
Funktionen der Anwendung. Beachten Sie, dass es, wie bei anderen Softwarelösungen, oft viele Möglichkeiten 
gibt, um auf eine bestimmte Funktion in Global Mapper zuzugreifen. Beispielsweise kann die Aktion Importieren 
ausgeführt werden durch: Menü Datei -> Datei(en) öffnen (File -> Open Data File), Button » Datei(en) öffnen (Open 
Data File)« in der Werkzeugleiste, Tastaturkürzel Ctrl+O. Im folgenden Text wird die Hauptfunktion von jedem Menü 
erläutert:

• Datei (File)

Das Datei-Menü enthält alle Optionen zum Importieren, Exportieren und Speichern von Daten. Es enthält auch 
eine Liste der zuletzt importierten Dateien.

• Editieren (Edit)

Die Funktion des Editieren-Menüs besteht darin, das Kopieren und Einfügen von Objekten zu aktivieren, die 
zugehörigen Optionen zu steuern und die Rückgängig/Wiederholen-Funktion zu verwalten.

• Ansicht (View)

Das Menü Ansicht enthält eine Reihe von Einstellungen, um die Darstellung der Benutzeroberfläche und der 
Karte selbst zu konfigurieren. Es gibt auch Optionen für die manuelle Anpassung der Zoomstufe und zum 
Sichern und Wiederherstellen einer bestimmten Kartenansicht.

• Werkzeuge (Tools)

Wie der Name andeutet, enthält das Werkzeuge-Menü eine Auswahl von Werkzeugen, die für die Interaktion 
mit den Objekten auf der Karte verwendet werden. Basierend auf der Auswahl ändert sich die Funktion des 
Cursors auf der Karte. Dieses Menü bietet auch Zugriff auf bestimmte andere Dialogfenster wie das Kontroll-
Center und die Karten-Layout-Optionen.

• Digitalisierer

Sämtliche Funktionen, die der Digitalisierer in der Bearbeitung von Vektorelementen bietet, sind unter diesem 
Menüpunkt zusammengefasst. Während ein Rechts-Klick auf Vektorelemente stets kontextsensitiv ist, haben 
Sie hier die komplette Übersicht über alle Optionen.

• Analyse (Analysis)

Das Analysis-Menü umfasst viele Analysefunktionen in einer praktischen Liste. Mit geladenen Höhendaten kön-
nen verschiedene Geländeanalysen ausgeführt werden wie die Erstellung von Konturen und die Abgrenzung 
von Wasserscheiden.

• Ebene (Layer)

Dieses Menü enthält verschiedene Ebenen-bezogene Funktionen.

• Suche (Search)

Dieses Suchmenü bietet verschiedene Optionen, um Objekt-Attribute abzufragen und zu editieren. Es enthält 
auch eine Adress-Suchfunktion, die eine Möglichkeit zur Geocodierung mit einschließt.

• GPS

Wenn ein kompatibler GPS-Empfänger mit Ihrem Computer verbunden ist, kann Ihre Position durch ein Symbol 
auf der Karte dargestellt werden. Das GPS-Menü steuert die Konfiguration und die Interaktion zwischen Global 
Mapper und Ihrem GPS-Gerät.

• Hilfe (Help)

Das Menü »Hilfe« bietet einen zentralen Zugriffspunkt für die verschiedenen Optionen und andere Ressourcen, 
die für Global Mapper verfügbar sind.

© Blue Marble Geographics • screen & paper GmbH
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2.2 Die Werkzeugleiste
Die verschiedenen Schaltflächen in Global Mappers Werkzeugleiste bieten die bequemste Art, ein Werkzeug aus-
zuwählen, bestimmte Dialogfelder zu öffnen oder zum Wechseln zwischen Funktionen. Falls erforderlich, können 
Gruppen von Buttons, gekennzeichnet durch eine Trennlinie, aus der Werkzeugleiste entfernt werden über die 
Option »Werkzeugleisten (Toolbar)« im Menü »Ansicht (View)« oder verschoben und an eine andere Position in der 
Werkzeugleiste angedockt werden. 

Werkzeuge der Datei-Symbolleiste

 
Kartenansichten

 
 
Favoriten

© Blue Marble Geographics • screen & paper GmbH

Ebenen-Kontrollcenter (Overlay-Control-
Center)aktiviert die Dialogbox für die 

Verwaltung der geladenen Daten lagen. 

Verbindung zu Online-Daten (Download Online 
Data) bietet Zugang zu einer Fülle von online-Da-

tenquellen wie WMS und WFS. 

Datei(en) öffnen (Open Data-Files) 
wird verwendet, um den Import von 
Daten in den unterstützten Formaten 

zu initiieren.

Arbeitsbereich speichern (Save) spei-
chert den Status aller importierten 
Daten, digitalisierten Objekte und 

Konfigurationseinstellungen in eine 
Arbeitsbereichsdatei.

Kartenlayout-Editor (Map Layout) 
dient dazu, eine druckfähige Karte zu 

gestalten und kartographische Elemente 
wie Maßstab, Legende und eine 

Kompassrose zur Karte hinzufügen. 

Symbolleisten-Optionen (Toolbar 
Options) erlaubt, Button der gewählten 
Werkzeugleiste zu entfernen oder hin-

zuzufügen oder auch individuelle Button 
anzulegen. 

Übersichtskarte (Overview Map) zeigt 
geladene Ebenen in einer dynamischen 

Übersichtskarte. 

Konfiguration (Configuration) öffnet das 
Konfigurationsfenster, das verwendet 

wird, um zahlreiche Einstellungen in der 
Software vorzunehmen.

Kartenansichten hinzufügen/entfer-
nen (Map View Manager) bietet die 

Möglichkeit, das Hauptkartenfenster zu 
unterteilen und mehrere Ansicht einzu-

betten. Das kann mehrere 2D-Ansichten, 
Pfadprofile oder eine 3D-Darstellung 

beinhalten.

Die  anpassbare Favoritenliste 
ermöglicht den einfachen 

Zugriff auf häufig verwendete 
Werkzeuge und ermöglicht, 

Tastenkombinationen  ausge-
wählten Funktionen zuzuwei-

sen.

Gewähltes Kommando ausführen 
(Run Selected Command) startet 

die in der Favoritenliste ausgewähl-
te Funktion.
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3 Das Dialogfeld Konfiguration
Das Dialogfeld Konfiguration kann über das Menü Werkzeuge -> Konfiguration (Tools -> Configuration) oder durch 
Klicken auf die Schaltfläche Konfiguration in der Werkzeugleiste geöffnet werden. Es vereint an einem Platz die 
Festlegung von Voreinstellungen, die viele der Eigenschaften und Funktionen der Software steuern.

Im folgenden sind die Einstellungen zusammengefasst, die auf jeder Registerkarte verfügbar sind:

• Voreinstellungen (General) 
»Voreinstellungen« vereint u.a. die Einrichtung von Standardeinheiten zum Messen, Festlegung von 
Kartengittern, Koordinatenformat. 
Unter »Erweitert« legen Sie u.a. das Verzeichnis fest, in dem temporäre Dateien gespeichert werden. Da 
Global Mapper, je nach Daten und Funktion, große Dateimengen in das temporäre Verzeichnis speichert, 
achten Sie auf ausreichenden Speicherplatz in diesem Verzeichnis!

• Vektoranzeige (Vector Display) 
Dieser Punkt zur Anzeige von Vektordaten dient zum Steuern der Darstellung von Punkt-, 
Linien- und Flächenobjekten auf der Karte. Optionen umfassen Filterung von Datentypen, Reihenfolge der 
Ebenen, Rendern gelöschter Objekte und Aktivieren oder Deaktivieren des »Einrastens« beim Zeichnen von 
neuen Objekten.

• Anzeigeoptionen (Display Options) 
Kartennetz, Maßstabsleiste und weitere Elemente können hier verwaltet werden.

• Stile (Styles) 
Unter diesem Punkt können Element-Darstellungstypen (Feature Types) erstellt und verwaltet werden, die 
Flächen, Linien oder Punkten zugewiesen werden. Das Anwenden eines Elementtyps auf ein Vektor-Objekt 
passt automatisch die Darstellung der Objekte an und weist - falls erforderlich - eine benutzerdefinierte 
Reihe von Attributen zu.
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• Projektion (Projection) 
Projektion wird verwendet, um die Projektion sowohl für die Darstellung am Bildschirm als auch für den 
Export zu verändern. Zahlreiche vorkonfigurierte Projektionen und Bezugs-Optionen sind verfügbar, und 
benutzerdefinierte Systeme können bei Bedarf hinzugefügt werden. Mit dieser Funktion projizieren Sie eine 
Ebene von einer in eine andere Projektion. 

• 3D-Ansicht-Eigenschaften (3D View Properties) 
Sämtliche Einstellungsparameter zur Anzeige von Daten in der 3D-Ansicht werden unter diesem Punkt ver-
waltet.

• Höhenoptionen (Vertical Options) 
Die Höhenoptionen bieten eine Reihe von Einstellungen, die die Anzeige von Höhendaten steuert. Diese 
Einstellungen umfassen die Auswahl eines Musters zur Schattierung, Anpassung von Hügel-Schattierungen 
oder Schatten-Darstellungen und das Rendering von einem simulierten Wasserstand in einer festgelegten 
Höhe.

• Schattierungsoptionen (Shader-Options) 
Die Schattierungsoptionen steuern die visuelle Darstellung von mehreren vorkonfigurierten Mustern zur 
Schattierung (Höhe und Neigung) und ermöglicht die Erstellung von neuen Mustern.

• LiDAR 
Die LiDAR-Registerkarte bietet Einstellungen zum Filtern einer Punktwolke basierend auf einer Klassifikation 
oder Rückgabewerten.

• Element-Vorlagen (Feature Templates) 
Die Funktion von Element-Vorlagen besteht darin, einen Satz von vorkonfigurierten Attributen zu erstellen, 
die den Prozess der Digitalisierung oder Datenerfassung optimieren, insbesondere bei der Verwendung von 
Global Mapper Mobile.

• GPS Optionen 
GPS Optionen bieten eine Reihe von Einstellungen, um den Tracking-Prozess bei einem angeschlossenen 
GSP-Empfänger zu kontrollieren.

Während das Dialogfeld Konfiguration den Zugriff auf die meisten Global Mapper Präferenzen und 
Einstellungsoptionen bietet, enthalten viele andere Komponenten der Software Objekt-spezifische Einstellungen, 
die eingerichtet werden, wenn Sie diese Funktion ausführen. Beispielsweise werden beim Exportieren einer Datei in 
einem bestimmten Format viele von den Einstellungen erst im Dialogfeld »Export Optionen« festgelegt.

Tipp: Nutzerspezifische Daten
Wenn Sie individuelle Dateien anlegen wie Templates, Symbole, ein eigenes Datum in den Projektionseinstellungen 
etc., dann finden Sie diese Daten im folgenden Verzeichnis:

• Benutzer\<Nutzer>\AppData\Local\GlobalMapper\
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4 Ebenen und Datenverwaltung

Das Kontrollcenter (Overlay-Control-Center)
Das Kontrollcenter ist Global Mappers Werkzeug zur Verwaltung 
der Ebenen. Es kann über das Werkzeug-Menü, mit einem Klick auf 
den »Kontrollcenter«-Button in der Werkzeugleiste oder mit der 
Tastenkombination Alt + C geöffnet werden. 

Das Kontrollcenter wird benötigt, um Ebenen anzuzeigen oder zu verber-
gen, bestimmte Charakteristiken der Ebenen einzustellen  
oder andere ebenen-spezifische Funktionen auszuführen.

Oberhalb der angezeigten geladenen oder erzeugten Ebenen  
erlauben eine Reihe von Button einen schnellen Zugriff auf wichtige 
Funktionen:

• Ebenen-Optionen

• Ebenen-Metadaten

• Attribut-Editor

• Elemente auswählen

• Zoomen

• Ein-/Ausblenden

• Entfernen einer Ebene (damit wird die Ebene dauerhaft gelöscht  
und alle nicht gespeicherten Änderungen gehen verloren)

Die Schlüsselkomponente des Ebenen-Kontrollcenter ist der Rechts-Klick. Das sich öffnende Dialogfeld wird einge-
setzt, um bestimmte Einstellungen im Zusammenhang mit einer Ebene festzulegen oder eine Reihe von Befehlen 
auszuführen. Die angezeigten Optionen variieren je nach der Art der Daten (Raster, Vektor, LiDAR oder Höhendaten) 
innerhalb dieser Ebene.

Das Dialogfeld Optionen
Die Registerkarten im Dialogfeld Optionen unterscheiden sich je nach Datentyp, der in 
der ausgewählten Ebene enthalten ist:

Vektoroptionen

Zu den Hauptfunktionen des Dialogfelds Vektoroptionen gehören die Verwaltung der 
Anzeige von Beschriftungen, Zuweisen von Merkmalen zu einer Merkmalstypkategorie 
und Anpassen der Anzeigeeigenschaften der Elemente der Ebene (Füllmuster, Symbolstil 
usw.).

Rasteroptionen

Das Dialogfeld Rasteroptionen enthält Werkzeuge zum Herstellen von Transparenz, 
Anpassen von Farbbalance, Kontrast usw. und Zuschneiden eines Bildes auf einen defi-
nierten Bereich.

Höhenoptionen

Die verfügbaren Höhenoptionen umfassen Werkzeuge zum Versetzen von Höhenwerten 
in der Ebene und zum Definieren des sichtbaren Höhenbereichs.

 
Jedes der Dialogfelder Optionen enthält Kartenzoom, um den Zoombereich zu steuern, in dem die Ebene angezeigt 
wird, und die Registerkarte Ebenen-Projektion, die verwendet wird, um die mit der ausgewählten Ebene verknüpf-
ten Koordinatenwerte neu zu interpretieren. Das Anpassen dieser Projektionsparameter führt dazu, dass der Inhalt 

Das Kontrollcenter mit zusätzlich aktivierter 
Übersichtskarte
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der Ebene physisch an eine neue Position verschoben wird und sollte nur durchgeführt werden, wenn Sie wissen, 
dass die ursprünglichen Koordinateneinstellungen falsch waren. Um Ihre Karte einfach neu zu projizieren, verwen-
den Sie den Abschnitt Projektion im Dialogfeld Konfiguration.

Arbeitsbereich (Workspace) speichern
Der Arbeitsbereich ist die Kernkomponente zum Management des Global Mapper. Damit können Sie Informationen 
über die Ebenen speichern, die auf der Karte angezeigt werden, sowie alle Einstellungen oder Konfigurationen, die 
auf diese Ebenen angewendet wurden. Vereinfacht ausgedrückt ist ein Arbeitsbereich eine Datei (*.gmw), die eine 
Momentaufnahme Ihrer aktuellen Kartenansicht aufzeichnet.

Um den Arbeitsbereich zu speichern, klicken Sie auf Speichern in der Werkzeugleiste oder wählen im Menü Datei 
-> Arbeitsbereich speichern (File ->Save Workspace....). Wenn noch kein Arbeitsbereich gespeichert wurde, werden 
Sie aufgefordert, einen Namen und einen Speicherort für die Datei anzugeben. 

Sie können auch ein Duplikat eines vorhandenen Arbeitsbereiches erstellen mithilfe des Menüs Datei -> 
Arbeitsbereich speichern als... (File ->Save Workspace As.....). Diese Funktion ist nützlich zur Erstellung einer 
Arbeitsbereichvorlage. Jeder Arbeitsbereich, der anhand dieser Vorlage mithilfe des Befehls Arbeitsbereich spei-
chern als... gespeichert wird, erbt alle Ebenen und Einstellungen vom Original und kann dann individuell angepasst 
werden.

Arbeiten mit importierten Ebenen
Ein wichtiger Aspekt bei der Arbeit mit Arbeitsbereichsdateien ist, dass sie nicht die Kartendaten aus importier-
ten Dateien enthalten. Stattdessen zeichnet der Arbeitsbereich den Pfad zum ursprünglichen Dateispeicherort 
sowie alle Änderungen oder Konfigurationen auf, die auf diese Ebene angewendet wurden. Wenn der Pfad zum 
Dateispeicherort unterbrochen wird, z. B. wenn Sie die Verbindung zu Ihrem Netzwerk trennen oder wenn die Datei 
gelöscht oder an einen neuen Speicherort verschoben wird, wird der Arbeitsbereich nicht korrekt geladen und eine 
Fehlermeldung wird angezeigt. Aus diesem Grund sollten Arbeitsbereichsdateien normalerweise nicht mit anderen 
Global Mapper-Benutzern geteilt werden.

Arbeiten mit digitalisierten Elementen
Punkte, Linien und Flächen-Elemente, die mit den Digitalisier-Werkzeugen von Global Mapper erstellt wurden, 
werden direkt in der Arbeitsbereichsdatei gespeichert. Änderungen oder Ergänzungen importierter Daten werden 
ebenfalls softwareintern archiviert und nur über die Exportfunktion auf die originalen externen Daten übernom-
men.

Global Mapper-Paketdateien
Eine effiziente Möglichkeit, Daten zwischen Global Mapper-Benutzern auszutauschen, besteht darin, eine Global 
Mapper-Paketdatei (.gmp) zu erstellen. Im Gegensatz zum oben genannten Arbeitsbereichsformat enthält eine 
Paketdatei alle Kartendaten von zuvor importierten Ebenen und behält alle Konfigurationseinstellungen und 
Änderungen bei, die auf diese Ebenen angewendet wurden. Eine einzelne Global Mapper-Paketdatei kann Daten in 
jedem Format (Raster, Vektor und/oder Höhe) enthalten und bietet als solche ein äußerst effizientes Werkzeug für 
den Austausch von Karten und räumlichen Daten zwischen Global Mapper-Benutzern.

Global Mapper Package-Dateien bieten auch eine einfache Möglichkeit, Backups wichtiger Datensätze zu erstellen, 
die im Falle eines Verlusts der Originaldaten oder eines Hardwarefehlers einfach wieder importiert werden können.
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5 Import von Daten

Unterstützte Datenformate
Eine der herausragenden Eigenschaften des Global Mapper ist der Umfang und die Vielzahl von Dateiformaten, 
die importiert werden können. In der aktuellen Version werden mehr als 300 Dateitypen unterstützt, darunter 
alle räumlichen Grafikformate wie ESRI Shapefiles, KML-Dateien und MrSID Bilddateien und LiDAR Punktwolken. 
Praktisch jede Art von Geodaten wird von Global Mapper unterstützt, einschließlich Raster-, Vektor-, 2D und 3D, ob 
georeferenziert oder nicht. Wenn Global Mapper Ihr Datenformat nicht unterstützt, wenden Sie sich an Blue Marble 
und das Software-Team wird ermitteln, ob eine Unterstützung möglich ist. Eine Liste der derzeit unterstützten 
Formate ist auf der Website bluemarblegeo.com im Abschnitt Global Mapper verfügbar.

Importieren von Vektor-, Raster- und Höhenebenen
Es gibt mehrere Möglichkeiten zum Importieren von Daten in Global Mapper: Menü Datei -> Datei(en) öffnen (File 
> Open Data File(s)), Button Datei(en) öffnen (Open Data File(s)) in der Werkzeugleiste, Tastenkombination STRG + 
O. Sie werden dann aufgefordert, die gewünschte Datei zu suchen, um den Importvorgang zu starten.

Abgesehen von Text-Dateien - wie unten erwähnt - werden alle Formate von Vektor-, Raster- und Höhendaten 
über das gleiche Dialogfeld importiert. Global Mapper ist in der Lage, die verschiedenen Formate zu unterscheiden 
und jeweils den entsprechenden Overlay-Typ automatisch zuzuweisen. Falls erforderlich, werden Sie aufgefordert, 
Koordinaten-Parameter festzulegen, das Datenformat für Dateien mit unkonventioneller Erweiterung zu überprüfen 
oder eine Datei manuell zu referenzieren, falls keine geografischen Referenzinformationen verfügbar sind. 

Wenn Sie Dateien importieren, ist es möglich mehrere Dateien auszuwählen, indem Sie die STRG- oder Shift-Taste 
gedrückt halten und die erforderlichen Dateien im Dialogfeld auswählen. Alternativ können Sie alle kompatible 
Dateien in einem angegebenen Ordner oder einer Verzeichnis-Struktur unter Verwendung des Befehls »Datei -> 
Alle Dateien in einem Verzeichnis öffnen (File > Open All Files in a Directory Tree)« öffnen.

Schließlich – und vielleicht am einfachsten – können Sie eine kompatible Datei per drag & drop auf das Fenster 
Global Mapper ziehen, um automatisch den Importvorgang zu starten.

Importieren von 
Textdateien
Für den Import von Textdateien gibt 
es  einen eigenen Befehl unter dem 
Menüpunkt Datei, da hier eine auto-
matische Erkennung nicht möglich 
ist - zu unterschiedlich und vielfältig 
können die Daten sein. 
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Georeferenzierung von Bilddateien
Die Georeferenzier-Funktion von Global Mapper bietet ein leistungsstarkes Werkzeug zum Erstellen einer geogra-
fisch referenzierten Rasterebene aus praktisch jeder Bilddatei oder PDF. Das Verfahren umfasst normalerweise das 
Identifizieren sichtbarer Merkmale im importierten Bild und die Zuweisung der entsprechenden Koordinaten.

Um ein Bild zu importieren, öffnen Sie es entweder über »Datei > Öffnen« (Ctrl +O) oder »Datei > Bilddatei georefe-
renzieren«. Im zweiten Fall haben Sie die Möglichkeit, die Datei direkt nach der Georeferenzierung zu exportieren.

Nach Auswahl der Datei wird das Dialogfeld »Georeferenzierung Bilddatei« angezeigt mit einen Überblick über 
das Bild, eine vergrößerte Ansicht des Bildes, in dem die Kontrollpunkte genau platziert werden können, und eine 
vergrößerbare Ansicht der aktuell geladenen Karte. Um den Prozess zu beginnen, klicken Sie auf einen markanten 
Punkt im Bild, klicken den korrespondierenden Punkt in der angrenzenden Karte und klicken auf den Button »Punkt 
zur Liste hinzufügen«. Wiederholen Sie diesen Prozess für einige zusätzliche Punkte, die so weit wie möglich ausei-
nander liegen. Alternativ können Sie manuell die X-/Y-Pixelwerte aus dem Bild eingeben und/oder die entsprechen-
den Koordinatenwerte aus bekannten Messwerten eingeben.

Nachdem alle Kontrollpunkte zugewiesen wurden, klicken Sie auf OK, um eine neue Rasterebene zu erstellen. Um 
fehlerhafte Registrierungspunkte zu korrigieren, wählen Sie die Ebene im Ebenenkontrollcenter mit der rechten 
Maustaste aus und wählen »REFERENZIEREN -> Ebenen-Position/Projektion ändern«.

Arbeiten mit räumlichen Datenbanken
Als Alternative zum Importieren von Dateien können fortgeschrittene Benutzer eine direkte Verbindung zu einer 
vorhandenen räumlichen Datenbank erstellen, die es Global Mapper ermöglicht, auf Vektordaten sowohl lesend als 
auch schreibend direkt aus der Datenbank zuzugreifen. Unter den unterstützten Datenbank-Typen sind ESRI ArcSDE, 
ESRI File und Personal Geodatabase, MS SQL Spatial, Oracle Spatial, PostGIS und Spatialite. Die ESRI-Datenbanken 
unterstützen auch Raster-Datenformate, sind aber nur kompatibel mit der 32-Bit-Version von Global Mapper.

Um eine Verbindung zu einer räumlichen Datenbank herzustellen, öffnen Sie den Spatial Database Verbindungs-
Manager (Connection Manager) (Werkzeuge -> Verbindungsmanager (Tools -> Connection Manager)), klicken auf die 
Schaltfläche »Neu« und geben die erforderlichen Einstellungen ein. 

Zum Importieren von Daten aus einer verbundenen Datenbank wählen Sie im Menü Datei -> Spatial Database öff-
nen (File -> Open Spatial Database), wählen den Namen der Datenbank, klicken auf »Öffnen« und wählen aus den verfüg-
baren Tabellen aus.
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6 Zugriff auf Online-Daten

Verwenden der Funktion Download Online Data
Ein guter Weg, um mit der Kartenerstellung mit Global Mapper zu beginnen, ist, einige der vielen kostenlosen 
Online Datasets herunterzuladen. Zahlreiche Behörden, Organisationen und Wirtschaftsunternehmen bieten direk-
ten Zugriff auf ihre räumlichen Daten-Archive über Web Map Service (WMS), Web Coverage Service (WCS) und 
andere Online-Protokolle. Global Mapper enthält vorkonfigurierte Links zu vielen von diesen Servern.

Um den Download-Vorgang zu starten, klicken Sie den Button »Verbindung zu Online-Daten« aus der 
Werkzeugleiste. Das daraufhin angezeigte Dialogfeld listet alle verfügbare Datenquellen auf, kategorisiert nach Typ 
oder nach geografischem Raum. Nach dem Erweitern einer Kategorienliste wählen Sie die erforderliche Daten-
Quelle und den Umfang der Daten zum Download unter Verwendung der Optionen am unteren Rand des Fensters.

Gelegentlich können Sie feststellen, dass der Dienst, den Sie benötigen, nicht verfügbar ist und Sie eine 
Fehlermeldung sehen. Das kann an routinemäßigen Systemwartungen, übermäßigem Datenverkehr oder anderen 
technischen Fragen liegen. Leider hat Blue Marble keine Kontrolle über die Verfügbarkeit dieser Quellen, daher 
ist es empfehlenswert, dass Sie die Daten in einer lokalen Datei speichern, um nicht ständig von den Streaming-
Diensten abhängig zu sein. Weitere Informationen finden Sie unten.

Premium-Datenquellen
Blue Marble hat Partnerschaften mit mehreren kommerziellen Datenanbietern, die einen bequemen Zugang zu 
qualitativ hochwertigen Bildern und Höhendatensets bieten. Wenn Sie eine der Premium Content Optionen im 
Dialogfeld Online-Datenquelle auswählen, werden Sie aufgefordert, die entsprechenden Login-Daten oder eine 
Datenzugriff-ID zum Herunterladen der Daten einzugeben. Informationen zum Abonnieren dieser Dienste erhalten 
Sie auf den Webseiten der Datenanbieter.

Hinzufügen von benutzerdefinierten Datenquellen
Während Global Mapper eine Reihe von vorinstallierten Kartenservices umfasst, können Sie auch benutzerdefinierte 
Online-Quellen hinzufügen. Viele GIS-Abteilungen nutzen das Internet als effizienten Weg, um Datensets bereitzu-
stellen. Mit Global Mapper können Sie einen direkten Link auf diese Daten einrichten. Im Dialogfeld »Online Daten« 
klicken Sie dazu auf »Neue Quelle hinzufügen (Add New Source)« und geben die entsprechende URL ein, um diese 
Verknüpfung herzustellen.

Speichern von Daten für die Offlineverwendung
Da die Verfügbarkeit von Streaming Data Services nicht garantiert werden kann, ist es empfohlen, eine lokale Kopie 
der Daten zu speichern. Damit wird nicht nur sichergestellt, dass Sie immer Zugriff auf die erforderlichen Ebene 
haben, die Geschwindigkeit in der Darstellung der Daten ist auch erheblich größer. 

Um heruntergeladene Daten zu speichern, klicken Sie im Menü »Datei (File)« und wählen» Export > Export Raster/
Image Format «, wählen ein Dateiformat und geben die Einstellungen nach Bedarf ein. Eine gute Formatwahl ist 
JPEG 2000 (.jp2), da es ein ausgewogenes Verhältnis zwischen Dateigröße und Bildqualität der Datei bietet. Vor 
dem Abschließen des Export klicken Sie auf die Registerkarte »Export Bounds« im Dialogfeld »Export Options« 
und wählen eine der verfügbaren Optionen zur geografische Ausdehnung der exportierten Datei. Sonst können Sie 
versehentlich eine extrem große Datei generieren. Hinweis: das Speichern von Daten dauert erheblich länger als die 
Anzeige auf der Karte, haben Sie also etwas Geduld.
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7 Datenexport

Generelle Überlegungen zum Export
Der effiziente Export und Austausch von Daten ist ein wesentlicher Bestandteil jedes GIS und spielt eine wich-
tige Rolle in der funktionalen Ausrichtung des Global Mapper. Genauso, wie die Software eine Vielzahl von 
Dateiformaten für den Import unterstützt, können ebenso Hunderte von Dateitypen exportiert werden und gewähr-
leisten die Interoperabilität mit unzähligen Anwendungen von Drittanbietern.

Beim Exportieren von Daten aus Global Mapper gibt es Punkte zu berücksichtigen:

• Alle kompatiblen Ebenen und/oder sichtbaren Objekte werden standardmäßig exportiert. Mit anderen 
Worten erstellt Global Mapper eine einzelne Datei für alle Ebenen durch die Zusammenlegung mehrerer 
Ebenen in einer Datei. Um den Inhalt einer (oder mehrerer) bestimmten Ebene zu exportieren, wählen Sie 
im Kontrollcenter eine Ebene (oder mit Strg mehrere Ebenen), klicken mit der rechten Maustaste und wählen 
die Option Ebene -> EXPORT - Export Ebene(n) in eine neue Datei... (Layer -> Export Layer(s) to new file).

• Es gibt keine automatisierten Prozesse für das Speichern von Änderungen oder Ergänzungen in einer impor-
tierten Datei. Um Änderungen an der Quelldatei zu speichern, müssen Sie die Ebene im gleichen Format 
exportieren und die ursprüngliche Datei überschreiben.

• Die Projektions- und Koordinaten-Einstellungen für alle exportierten Daten sind in der Projektion-
Registerkarte im Dialogfeld Konfiguration eingestellt. Ungeachtet der ursprünglichen Projektions-Parameter 
der importierten Ebene wird diese globale Projektion allen Exporten zugewiesen.

• Jedes Exportformat hat im Export-Dialogfenster eine Reihe von formatspezifischen Einstellungen, die auf die 
exportierte Datei angewendet werden. Allen Formate gemeinsam ist die Option Ausdehnung Export (Export 
Bounds), die dazu dient, die geografische Ausdehnung der exportierten Daten zu begrenzen, und eine Option 
zum Kacheln (Tiling), mit der eine einzige große Datei in mehrere kleinere Dateien aufgeteilt werden kann.

Global Mapper-Paket-Dateien exportieren
Beim Austausch von Daten mit anderen Benutzern von Global Mapper ist das Global Mapper-Paket-Format zu 
bevorzugen. Dieses proprietäre Format unterstützt alle kompatible Datentypen und ermöglicht, mehrere Ebenen 
gleichzeitig in einer einzigen komprimierten Datei zu übertragen. Beim Importieren wird die Global Mapper-
Paketdatei die Ebenenstruktur der Originaldaten wieder herstellen.

Global Mapper-Paketdateien können auch als Mittel zur Sicherung von kritischen Datasets eingesetzt werden. 
Dadurch wird sichergestellt, dass die Daten bei einem Verlust der ursprünglichen Daten oder einem Hardware-
Ausfall wiederhergestellt werden können. Um eine Package-Datei zu erstellen, klicken Sie im Menü Datei (File) und 
wählen Export > Export Global Mapper Package Datei....

Exportieren von Vektor-, Raster- und Höhenebenen
Anders als beim Importvorgang, bei dem ein einzelner Open-Befehl verwendet wird für den Zugriff auf alle kompa-
tiblen Daten, erfordert das Exportieren die Auswahl eines Datentyps – das Menü Export strukturiert die verfügbaren 
Datentypen. Die Auswahl eines Formats für die exportierten Daten hängt von der beabsichtigten Verwendung der 
Daten und der Kompatibilität mit der Drittsoftware ab, in die sie importiert werden.

In eine räumliche Datenbank exportieren
Auf die gleiche Weise, wie Global Mapper eine nahtlose Möglichkeit zum Importieren von Daten aus einer räum-
lichen Datenbank bietet, können alle geladenen Daten, unabhängig von ihrer Herkunft, in die unterstützten 
Datenbank-Formate geschrieben werden. Wie beim Datenexport in Dateiformate bietet das Untermenü »Export« 
drei Datenbank-Export-Optionen an: Raster, Vektor und Höhe.
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Web-fähige Dateien exportieren
Global Mapper bietet verschiedene Optionen zum Erstellen von Web-fähigen Dateien aus jeder geladenen Daten-
Ebene. Das Menü Datei -> Export bietet die Option Export Web-Format, die ein Dialogfeld öffnet, in dem das 
gewünschte Format ausgewählt werden kann. Verschiedene Optionen zur Erstellung der Kacheln (Tiles) sind verfüg-
bar wie Google und Bing Map Tiles. Die Auswahl eines gekachelten Formats produziert mehrere Bildkacheln sowie 
eine zugehörige HTML-Datei, die automatisch die Kartenschnittstelle, Steuerelemente und die Basiskarte für das 
gewählte Format erzeugt.

Der Web-Export-Format-Befehl bietet auch die Option, Keyhole Markup Language (KML oder KMZ) Dateien zu 
erstellen, die in Google Earth oder Google Maps importiert werden können.

Global Mapper Mobile-Dateien exportieren
Mit Global Mapper Mobile liegt eine App für mobile Geräte vor, die gewissermaßen als »verlängerter Arm« des 
Global Mapper bezeichnet werden kann. Die App ermöglicht, von Global Mapper exportierte Datensets mit in das 
Gelände zu nehmen, dort zu ergänzen und zu erweitern und anschließend wieder in die Desktop-Applikation zu 
übernehmen. 

Vektor-, Raster- und Höhendaten werden über den Befehl Datei -> Export -> Export Global Mapper Mobile-Datei... 
zusammengefasst und können auf das mobile Gerät kopiert werden. Über einen Datenabgleich (z.B. in iTunes) oder 
über E-Mail werden diese GMMP-Dateien übertragen.

Global Mapper und MangoMap
MangoMap ist ein Online-Kartendienst, mit dem Blue Marble das Produkt Global Mapper eng verzahnt hat. Das 
Einrichten einer Online-Kartensite über Mango erfordert keine speziellen Webentwicklungskenntnisse oder Server, 
und der gesamte Vorgang dauert Minuten.

 Ab Version 21 können Global Mapper-Benutzer ihr eigenes MangoMap-Konto einrichten und Kartendaten direkt 
aus Global Mapper veröffentlichen. Benutzer haben die Möglichkeit, Online-Kartenportale zu erstellen, Karten für 
Kunden im Internet freizugeben oder Karten auf internen Websites zu veröffentlichen, um Projektinformationen 
für andere Mitarbeiter freizugeben. MangoMap-Webkarten können mehrere Ebenen mit Legenden und 
Abfragewerkzeugen enthalten und bieten so eine dynamische Möglichkeit zum einfachen Austausch von Geodaten.
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8 Drucken einer Karte
Vor dem Senden einer Karte an einen ange-
schlossenen Drucker bietet Global Mapper ein 
leistungsstarkes Seitenlayout-Tool, mit dem 
kartografische Elemente wie Titel, Legende und 
Maßstabsleiste zur Karte hinzugefügt werden 
können. Mit einem What-you-see-is-What-you-
get-Ansatz vereinfacht der Map Layout Editor 
die Erstellung einzelner Karten oder Mapbooks.

Erstellen eines Geospatial-PDF
Durch das Erfassen einer Kartenansicht im 
Portable Document Format (PDF) kann die 
Karte mit praktisch jedem geteilt werden, unab-
hängig vom Betriebssystem ihres Computers. 
Die PDF-Exportfunktion von Global Mapper 
behält auch die inhärente Ebenen-Struktur und 
geografische Referenzinformationen bei, sodass 
der Map Viewer Ebenen nach Bedarf ein- und 
ausschalten kann, die Koordinaten sehen kann, 
wenn der Cursor über die Karte bewegt wird, 
und einfache kartografische Funktionen ausfüh-
ren kann, wie z.B. Entfernungen messen.

Das Exportieren einer PDF-Datei ähnelt 
dem Senden einer Karte an einen 
Drucker und umfasst viele der gleichen 
Einrichtungsoptionen. Um eine PDF-Datei zu 
erstellen, klicken Sie auf Datei > Exportieren > 
PDF-Datei exportieren… Außerdem kann eine 
Geodaten-PDF im Fenster des Kartenlayout-
Editor erstellt werden. 

Bildschirminhalt als Bild speichern
Das Kartenfenster kann über das Menü Datei -> Bildschirminhalt als Bild 
speichern (Capture Screen Contents to Image...) direkt in eine Bilddatei geschrie-
ben werden. Der große Vorteil gegenüber einem normalen Screenshot ist 
die Option, die Größe zu erhöhen und GIS-spezifische Dateien mit zu spei-
chern.
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9 Vektordaten digitalisieren und editieren

Das Digitalisier-Werkzeug
Der Digitalisierer ist wohl das mächtigste Werkzeug in Global Mapper. Damit können Sie Punkte, Flächen und 
Linienobjekte auf der Karte erstellen, löschen, bearbeiten, verschieben, neu konfigurieren und kopieren. Auf die am 
häufigsten verwendeten Digitalisier-Komponenten können Sie direkt aus der Werkzeugleiste am oberen Fensterrand 
zugreifen. Viele weitere Werkzeuge stehen zur Verfügung, wenn Sie mit der rechten Maustaste auf der Karte nach 
der Aktivierung des Digitalisierers klicken.

Zunächst ist der Digitalisierer ein Auswahl-Werkzeug. Nach dem Klicken auf den Digitalisier-Button in der 
Werkzeugleiste wird die Position des Cursors durch ein Fadenkreuz angezeigt mit dem Wort »EDIT« unterhalb. 
In diesem Modus können Punkte, Linien und Flächen angewählt werden in Vorbereitung zur Bearbeitung, zum 
Verschieben etc.. Einzelne Objekte können durch einen direkten Klick ausgewählt werden, mehrere Objekte können 
durch Klicken und Ziehen einer Box ausgewählt werden oder indem Sie die STRG-Taste beim Markieren mehrerer 
einzelner Objekte gedrückt halten.

Freihand-Zeichenfunktionen
Folgenden Schaltflächen werden verwendet, um Vektor-Objekte auf der Karte manuell zu erstellen:

  
           1       2      3       4      5      6

1. Punkt-Objekte oder Text wird durch dieses Werkzeug erstellt mit einem Klick auf die gewünschte Position auf 
der Karte.

2. Der Linienwerkzeug-Knoten-Modus wird verwendet, um Linienobjekte zu erstellen. Klicken Sie nacheinander 
für jeden Punkt. Die Linie wird mit der rechten Maustaste beendet.

3. Das Linienwerkzeug Freihand-Modus erlaubt, Freihandlinien zu erstellen. Klicken Sie, halten die Maustaste 
gedrückt und bewegen Sie sie.

4. Erstellen von Flächen oder Polygonen durch wiederholten Linksklick auf die Karte. Rechte Maustaste, um den 
letzten Punkt hinzufügen, der automatisch mit dem ersten Punkt verbunden ist.

5. Erstellen von regelmäßigen Rechtecken durch einen Linksklick und ziehen der Maus zur gegenüberliegenden 
Ecke. Um ein Quadrat zu erstellen, ziehen Sie bei gedrückter Shift-Taste.

6. Ähnlich wie bei dem Rechteckwerkzeug, erstellt das Rechteck-Linienwerkzeug Quadrate oder Rechtecke 
(Linksklick und ziehen der Maus). In diesem Fall wird nur die Umriss-Linie gezeichnet.

Wenn Sie eines dieser Werkzeuge verwenden, löst die Beendigung der Zeichenfunktion die Anzeige der Dialogbox 
»Element-Info modifizieren« aus, in dem Sie Name, Objekt-Typ, Attribute und Zielebene zuweisen.

Zusätzliche Digitalisier-Schaltflächen
Die Global Mapper-Werkzeugleiste enthält einige zusätzliche Button zur Aktivierung von speziellen Werkzeugen 
zur Erstellung von Vektoren. Das COGO-Werkzeug wird verwendet, um Linien- oder Flächenobjekte zu erstel-
len durch die Eingabe von Abmessungen. Das Bereichsringe (Range Ring)-Werkzeug generiert konzentrische 
Kreisflächenobjekte von einer bestimmten Dimension um einen Punkt. Und das Raster-Werkzeug dient zum 
Erstellen einer Anzahl von Rastern mit einer benutzerdefinierten Breite und Höhe.

Die meisten verbleibenden Schaltflächen auf der Werkzeugleiste Digitalisierer sind für das Editieren von ausgewähl-
ten Vektorobjekten und werden weiter unten besprochen.
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Erweiterte Digitalisier-
Werkzeuge
Während die meisten Standard Vektor-
Funktionen mit Hilfe der zuvor aufge-
führten Schaltflächen erstellt werden 
können, gibt es eine Reihe von zusätzli-
chen Digitalisier-Werkzeug, auf die Sie 
durch einen Rechtsklick auf die Karte 
zugreifen. Diese Werkzeuge sind in 
Untermenüs nach Typ (Flächen, Linien 
und Punkte) organisiert und bieten 
erweiterten Zeichenfunktionalität.

Dialog-Box Elementinfo modifizieren
Das Dialogfeld Elementinfo modifizieren wird angezeigt, nachdem ein neues 
Element erstellt wurde oder wenn die Option Rechtsklick -> »EDIT– Element 
editieren« gewählt wird, nachdem ein Element mit dem Digitalisier-Werkzeug 
ausgewählt wurde. Dieses Dialogfeld enthält Optionen zum Festlegen der 
Ziel-Ebene für das Element, Stileinstellungen und Werkzeuge zum Hinzufügen 
oder Bearbeiten von Attributen.

Die Dropdown-Liste Elementtyp bietet die Möglichkeit, das ausgewählte 
Element einer vorformatierten Klassifizierung zuzuordnen, die automatisch 
die visuellen Merkmale sowie die diesem Typ zugeordneten Attributfelder 
bestimmt. Zusätzliche Element-Typen können der Liste hinzugefügt werden, 
indem Sie auf die Schaltfläche Neuen Typ erstellen klicken.

Editieren von Vektorobjekten
Global Mapper bietet Werkzeuge sowohl für die Bearbeitung der Geometrie 
und der Abbildung der Vektor-Objekte als auch für die Attribute oder die 
Informationen, die jedem Objekt zugeordnet sind. Bearbeitungen können auf 
Objekte angewendet werden, die in Global Mapper erstellt wurden oder aus 
einer importierten Vektorebene. Beachten Sie, dass Änderungen, die an einer 
importierten Ebene vorgenommen wurden, nicht direkt auf die Quelldatei 
angewendet werden. Die Ebene muss exportiert werden, um diese Updates 
in das ursprüngliche Dateiformat zu übernehmen.

 Vor Beginn jeder Editier-Funktion müssen das oder die Objekte mit dem 
Digitalisier-Werkzeug wie vorher beschrieben ausgewählt werden. Die Auswahl 
eines Objekts aktiviert zusätzliche Schaltflächen in der Werkzeugleiste, die solche 
Möglichkeiten wie Verschieben, Drehen, Skalieren und Konvertieren von Objekten 
anbieten. Zusätzliche geometrische Bearbeitungsoptionen stehen mit der rechten 
Maustaste zur Verfügung. 

Global Mapper bietet auch die Möglichkeit, die Form und Größe der einzelnen 
Linien oder Flächen zu bearbeiten durch Hinzufügen, Verschieben oder Löschen 
von Knotenpunkten. Um diese Funktion zu aktivieren, stellen Sie sicher, dass die 
Option zum Anzeigen der Eckpunkte für ausgewählte Objekte (Klick mit der rechten 
Maustaste -> Optionen) aktiviert ist. Knotenpunkte können dann mit dem Digitalisier-
Werkzeug ausgewählt und mit Hilfe der rechten Maustaste (Knoten editieren (Vertex 
Editing)) auf verschiedene Weise geändert werden.

Um den Originalzustand wiederherzustellen, wählen Sie das Objekt aus mit dem 
Digitalisier Werkzeug und wählen Sie »Bewegen/Umformen von Elementen-
>Ursprüngliche Form wiederherstellen (Move/Reshape Element(s) > Restore Original 
Shape of Selected Elements)«.
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Löschen von Elementen
Der einfachste Weg, ein Objekt in Global Mapper zu löschen, 
ist die Auswahl mit dem Digitalisier-Werkzeug und der Einsatz 
der ENTF-Taste auf der Tastatur. 

Obwohl das Objekt aus der Ansicht entfernt wurde, ist es 
nicht dauerhaft gelöscht und kann bei Bedarf problemlos wie-
derhergestellt werden. Über das Tastenkürzel Strg + Z sofort 
nach dem Löschen der Funktion wird die Löschung rückgän-
gig gemacht. Sie können auch die Rückgängig-Funktion des 
Global Mapper nutzen, um mehrere Schritte rückgängig zu 
machen. 

Alternativ können Sie die Anzeige aller gelöschten Objekte 
umkehren mithilfe der Tastenkombination Strg + Shift + 
D. Mit dem Digitalisier-Werkzeug und Klick mit der rech-
ten Maustaste wählen Sie die Option »Wiederherstellen/
Undelete« zum Wiederherstellen.
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10 Attributverwaltung

Stellvertretend für das »I« in GIS stehen die Attribute, also Daten, die den räumlichen Objekten zugeordnet sind, 
die auf der Karte dargestellt werden. Attribute beschreiben das Objekt und erleichtern die verschiedenen Filter-, 
Analyse- und Abfrage-Funktionen, die geografische Muster oder Verteilungen in den Daten greifbar machen.

Die im vorherigen Abschnitt beschriebene Dialog-Box Elementinfo modifizieren bietet die Möglichkeit, Attribute für 
ein oder mehrere ausgewählte Elemente manuell hinzuzufügen oder zu bearbeiten. Es können neue Attributfelder 
erstellt und die entsprechenden Werte manuell eingegeben werden. Bei einer großen Anzahl von Elementen kann 
dies ein zeitaufwändiger und mühsamer Prozess sein. Daher wird normalerweise empfohlen, Attributfelder automa-
tisch anzuwenden, indem man sie einem geeigneten Element-Typ zuweist oder, wenn möglich, Attribute aus einer 
externen Quelle zusammenführt.

Der Attribut-Editor
Der Attributeditor wird über die Symbolleistenschaltfläche des Kontrollzentrums oder durch Klicken mit der rechten 
Maustaste auf einen oder mehrere Ebenen im Kontrollzentrum aufgerufen und bietet eine tabellarische Anzeige 
aller Attributdaten für jede Ebene, unterteilt in einzelne Registerkarten. In diesem Dialogfeld können Attribute abge-
fragt, sortiert, bearbeitet und exportiert werden.

 
Zusammenfügen und Berechnen von Attributen
Der Vorgang des Zusammenfügens (Join) in Global Mapper ermöglicht, externe Daten entsprechenden Objekten 
in einer vorhandenen Ebene zuzuweisen und damit ein zusätzliches Attributfeld zu erzeugen. Vor dem Einsatz 
dieses Verfahrens ist es wichtig, dass die einzelnen Objekte über ein Attribut verfügen, dessen Werte einem 
entsprechenden Attribut in den zu verknüpfenden Daten entsprechen. Die Verknüpfung kann auf einer »Eins zu 
Eins«-Übereinstimmung beruhen, bei der jeder Eintrag in den importierten Daten nur einem Objekt auf der Karte 
entspricht, oder es kann auf der Grundlage einer »Eins-zu-Vielen«-Übereinstimmung beruhen, bei der mehreren 
Objekten auf der Karte der Wert eines einzelnen Eintrags in den verknüpften Daten zugewiesen wird.

Um die Join-Vorgang zu starten, klicken Sie mit der rechten Maustaste auf die Zielebene in dem Kontrollcenter und 
wählen Ebene -> VERBINDEN (Layer -> JOIN Table). Unterstützte Formate für externe Tabellendaten sind .txt, .csv, 
.xls/.xlsx und .dbf.
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Die Attribut-Berechnungs-Funktion, auf die auch durch einen Rechtsklick auf die Ebene im Kontroll-Center zuge-
griffen wird, wird verwendet, um ein neues Attributfeld zu erstellen, auf das eine Berechnung oder Formel basie-
rend auf einem vorhandenen Attribut angewendet wird. Berechnungsoptionen umfassen standard-numerische 
Operationen wie z. B. Hinzufügen und Multiplizieren, text-basierte Vorgänge wie z. B. Anhängen oder Voranstellen 
von Text  oder erweiterte Operationen.

Erweiterte Attribut-Optionen
Global Mapper bietet mehrere Optionen, um Attribute automatisch zu erstellen oder zu aktualisieren. Nach 
der Auswahl eines oder mehrerer Objekte auf der Karte mit dem Digitalisier-Tool bietet das Kontextmenü ein 
Untermenü Attribut/Stil Funktionen (Attribute/Style Functions), das für die automatische Zuweisung der Attribute 
mit einer Vielzahl von Kriterien verwendet werden kann. Mit einer darunterliegenden Ebene mit Höhendaten 
können Sie z.B. Werte wie Höhe und Neigung zuweisen. Oder Sie fügen ein Attribut hinzu, das die Anzahl von 
Punktobjekten innerhalb eines ausgewählten Bereichs zeigt.
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11 Verwenden der 3D-Funktionalität

Um die 3D-Funktionalität von Global Mapper nutzen zu können, müssen die Daten, mit denen Sie arbeiten, einen 
inhärenten Höhen- oder Höhenwert aufweisen. Sowohl Vektor-Elemente als auch entsprechend formatierte Raster-
Ebene können diesen „Z“-Wert enthalten und können in einer dreidimensionalen Perspektive modelliert werden.

Die häufigste Anwendung für 3D-Daten ist die Generierung einer Geländeoberfläche, die die Grundlage vieler 
analytischer Funktionen von Global Mapper ist. Ein Höhenwert kann auch auf ein Vektor-Element oder auf ein-
zelne Knotenpunkte angewendet werden, die ein Vektor-Element umfassen, wodurch das Element aus einer 
Geländeoberfläche extrudiert werden kann.

Wo finde ich 3D-Daten
Wie bei den Standard-Raster- und Vektordatenformaten gibt es zahlreiche Quellen für 3D- oder Höhendaten. Die 
Funktion »Online-Daten herunterladen« von Global Mapper bietet mehrere vorformatierte Datensätze, die kosten-
los oder über ein Abonnement bei einem der aufgeführten Datenanbieter heruntergeladen werden können. Global 
Mapper unterstützt auch Dutzende bereits vorhandener Höhenformate, wie DEM- und Arc-/Info-Grid-Dateien, die 
mit dem normalen Datei->Import-Prozess importiert werden. Einfache Textdateien, die Höhenwerte zusammen mit 
Koordinaten enthalten, können mit dem Befehl Datei > Generische ASCII-Textdatei(en) importieren importiert und 
gerastert werden, um eine Höhen-Ebene zu erstellen. Schließlich können LiDARDaten (Light Detection and Ranging) 
importiert und verarbeitet werden, um ein hochauflösendes Oberflächenmodell zu erstellen.

Erstellen einer Geländeebene aus 
3D-Vektorelementen
Das Generieren einer Raster-Höhen-Ebene aus einem Array von 
Vektor-Elementen, die einen Höhenwert enthalten, umfasst das 
Rastern der Daten. Dieses Verfahren folgt normalerweise dem 
Import einer XYZ-Textdatei oder LIDAR-Datei, kann aber auch mit 
anderen Vektordateien wie Konturen durchgeführt werden. Um ein 
Höhenraster aus einer ausgewählten Ebene zu erstellen, klicken 
Sie im Kontrollzentrum mit der rechten Maustaste auf die Ebene 
und wählen »Analyse > RASTER« oder klicken in der Analyse-
Symbolleiste auf die Schaltfläche Höhenraster erstellen. In beiden 
Fällen wird das Dialogfeld Optionen zur Erstellung von Höhenraster 
angezeigt, das eine Reihe von Optionen zum Konfigurieren des 
Rasterprozesses bietet.

3D-Optionen und -Einstellungen
Standardmäßig wird eine Höhen-Ebene mit der mehrfarbigen 
Atlas-Schattierung angezeigt, obwohl es in der Dropdown-Liste 
»Schattierungen« mehrere zusätzliche Optionen gibt. Ein simu-
lierter Hügelschatten oder Schatteneffekt wird auch angewen-
det, um Variationen im Gelände hervorzuheben. Dies kann mit 
der Schaltfläche »Hügelschattierung« deaktiviert werden. Im 
Konfigurationsdialog können weitere 3D-Optionen eingerichtet wer-
den.
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Visualisierung der Karte als 3D-Modell
Ein zusätzliches Kartenfenster in Global Mapper bietet die Möglichkeit, alle Daten mit einem Höhen- oder 
Höhenwert als dreidimensionales Modell anzuzeigen. Dieses Fenster wird über die Schaltfläche 3D-Ansicht in der 
Viewer-Symbolleiste geöffnet und kann auch neben der entsprechenden 2D-Karte angedockt werden.

Viele der Zoom- und Schwenkfunktionen, die in der 2D-Kartenansicht verwendet werden, stehen auch im 
3D-Fenster zur Verfügung. Mit zusätzlichen Tools lässt sich die vertikale Überhöhung verändern, die Perspektive auf 
Bodenniveau ändern und Wasserüberschwemmung simulieren. Das 3D-Fenster enthält auch eine Funktion, mit der 
die aktuelle 3D-Ansicht für einen späteren Aufruf gespeichert werden kann. Weitere Einstellungen der 3D-Ansicht 
finden Sie im Abschnitt »3D-Ansichtseigenschaften« der Konfiguration.

Arbeiten mit Punktwolkendaten
Mit der zunehmenden Verfügbarkeit von 3D-Datenquellen und Erfassungsmethoden werden immer mehr 
Punktwolkendaten verwendet, um hochpräzise Geländemodelle, Netze und andere 3D-Daten zu erstellen. Global 
Mapper arbeitet sowohl mit LIDAR-Daten (Light Detecting and Ranging) als auch mit photogrammetrisch abge-
leiteten Punktwolkendaten. In seinem nativen Format ist dies eine Reihe eng beieinander liegender Punkte, von 
denen jeder genaue Koordinaten, eine Höhe, möglicherweise eine Klassifizierung enthält, die die Art des Merkmals 
angibt, das der Punkt darstellt (Boden, Vegetation, Gebäude usw.) und mehrere zusätzliche Attribute. Jüngste 
Entwicklungen in Global Mapper haben die Unterstützung sowohl für die Standard-LIDAR-Dateien (.las und .laz) als 
auch für andere Punktwolkenformate erweitert. Global Mapper Pro bietet fortschrittliche LIDAR-Verarbeitungstools.

© Blue Marble Geographics • screen & paper GmbH
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LiDAR-Daten werden mit dem Standardimportverfahren (Strg+O) importiert, das anschließende Dialogfeld mit den 
LiDAR-Importoptionen ist jedoch nur für dieses Format verfügbar. In diesem Fenster können die Daten gefiltert, 
abgetastet und bei Bedarf direkt in eine Höhenebene gerastert werden.

Nach dem Import werden die Punkte in den Farben der aktuell ausgewählten Schattierung angezeigt und geben 
den Höhenwert wieder, wenn keinem Punkt RGB-Werte zugewiesen wurden. Im Dialogfeld Optionen der Ebene 
kann die Anzeige der Punkte geändert werden, um andere Variablen wie Klassifizierung oder Intensität darzustellen. 
Einzigartig in diesem Format ist auch die Edit-Funktion, auf die Sie durch Rechtsklick zugreifen können, nachdem Sie 
einen oder mehrere der LIDAR-Punkte mit dem Digitalisierer ausgewählt haben. In diesem Dialogfeld können die 
Klassifizierung des Punktes bearbeitet und andere Attribute geändert werden.

3D-Analysefunktionen
Global Mapper bietet verschiedene Analysewerkzeuge, die geladene Höhen- oder Gelände-Ebenen verwenden.

Wassereinzugsgebiets-Analyse

Dieses Werkzeug wird verwendet, um ein Gelände hinsichtlich seiner wasserbezogenen Eigenschaften zu 
untersuchen. Sowohl Flüsse und Abflussverhalten werden analysiert als auch Wassereinzugsgebiete und 
Wasserscheiden.

Pfadprofil/Sichtbarkeitslinie

Ein Pfadprofil ist eine Querschnittsansicht des Geländes, dargestellt durch ein Linien-Element. Die 
Sichtbarkeits-Analyse, die nur mit einer einzelnen Segmentlinie funktioniert, zeigt, wo Hindernisse die Sicht 
oder den Übertragungsweg von einem Ende der Linie zum anderen behindern.

Sichtbarkeitsanalyse

Dieses Werkzeug skizziert, welche Bereiche bezogen auf einen definierten Standort sichtbar sind oder 
sich innerhalb eines Sendebereichs befinden. Optionen wie Azimutbereich, Entfernung und Höhe des 
Ursprungspunkts können im Dialogfeld zur Einrichtung der Sichtfeldanalyse angepasst werden.

Simulation von Wasserstandsanstieg/-hochwasser

Basierend auf einem ausgewählten Gebiet oder dem tatsächlichen Meeresspiegel umreißt das Werkzeug 
die Gebiete, die von einem bestimmten Anstieg des Wasserspiegels betroffen sind.

Höhenlinien

Die Erstellung von Höhenlinien ist eine der häufigsten Anwendungen für Höhendaten in Global Mapper. Die 
Optionen ermöglichen das Festlegen des Konturintervalls, das Erstellen zusätzlicher Flächen-Elemente und 
das Anwenden anderer Einstellungen.

© Blue Marble Geographics • screen & paper GmbH
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Berechnen des Volumens zwischen Oberflächen

Wenn zwei überlappende Höhenschichten geladen sind, z. B. eine Oberflächen- und eine Untergrundebene, 
berechnet dieses einfache Werkzeug das Materialvolumen zwischen den beiden.

Vergleichen/Zusammenfügen von Geländeoberflächen

Dieses Werkzeug erstellt eine neue Höhen-Ebene aus einer Operation oder Berechnung, die auf die 
Höhenwerte in zwei überlappenden Ebenen angewendet wird. Zu den Operatoren gehören Subtraktion, 
Durchschnitt und Maximum.

Berechnung von Auf- und Abtragsmengen

Als Rechtsklick-Option verfügbar, wenn entweder ein Linien- oder Flächen-Element mit dem Digitalisierer 
ausgewählt wurde, bestimmt das Werkzeug das Materialvolumen, das entfernt und/oder hinzugefügt wer-
den muss, um eine künstlich abgeflachte Oberfläche zu erzeugen.

Zuweisen von Höhe oder Tiefe zu Vektormerkmalen
Jedes Punkt-, Linien- oder Flächen-Element kann einen zugeordneten Z-Wert haben, wodurch es in einer 
3D-Umgebung relativ zu anderen Vektor-Elementen oder zu einer geladenen Geländeoberfläche modelliert werden 
kann.

Beim Importieren einer Vektorebene sucht Global Mapper automatisch nach einem vorhandenen vertikalen 
Attribut wie Elevation oder Höhe und verwendet dies als Z-Wert. Um einen Z-Wert manuell zuzuweisen, fügen Sie 
einfach ein neues Attribut zu dem oder den erforderlichen Elementen hinzu und geben Sie die Höhe oder Tiefe 
ein. Um sicherzustellen, dass Global Mapper dieses Attribut als Z-Wert erkennt, öffnen Sie das Dialogfeld Optionen 
für die Ebene im Kontrollzentrum und wählen das entsprechende Attributfeld aus der Dropdown-Liste »Höhen aus 
Attributwert abrufen« auf der Registerkarte »Höhen«.

Es ist auch möglich, jedem Stützpunkt, der ein Linien- oder Flächen-Element umfasst, einen eindeutigen Z-Wert 
hinzuzufügen. Dieses Verfahren wird durch Klicken auf die Schaltfläche »Knoten« im Dialogfeld »Element-Info modi-
fizieren« für ein ausgewähltes Element eingeleitet.

Arbeiten mit 3D-Modellen oder Netzen
Global Mapper unterstützt mehrere 3D-Modellformate, 
einschließlich OBJ-, DAE- und STL-Dateien. Diese werden 
in der 2D-Kartenansicht als Top-Down-Vektor-Elemente 
gerendert, nehmen jedoch ihre vollen 3D-Eigenschaften 
an, wenn sie in der 3D-Ansicht angezeigt werden. Mit 
Global Mapper Pro können 3D-Modelle aus ausge-
wählten Punkten in einer Punktwolken-Ebene oder als 
Nebenprodukt des »Punktwolken aus Bildern«-Werkzeugs 
erstellt werden.

© Blue Marble Geographics • screen & paper GmbH
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Erstellen einer 3D-Durchflug-Aufnahme
Global Mapper bietet ein einfaches Werkzeug zum 
Erstellen einer Videodatei, die einen benutzerdefinierten 
Pfad durch eine beliebige 3D-Umgebung aufzeichnet. Das 
Erstellen des Pfads wird mit dem Digitalisier-Werkzeug 
eingeleitet und kann eine gezeichnete Linie, ein importier-
tes Linien-Element oder eine GPS-Track-Datei verwenden. 
Die Linie selbst muss keine besonderen Merkmale oder 
Attribute enthalten, sondern dient lediglich dazu, den 
Flugverlauf zu definieren.

Nach Auswahl der Linie ist die Schaltfläche »Durchflugpfad 
erstellen« in der Analyse-Symbolleiste verfügbar. Durch 
Klicken auf diese Schaltfläche wird das Dialogfeld geöff-
net, in dem die Flugeinstellungen festgelegt werden. Diese 
Einstellungen umfassen Höhe über Grund, Flugdauer, 
Kamerawinkel und Neigung.

Im 3D-Viewer steuern eine Reihe von Schaltflächen die Vorschau, Wiedergabe und Aufnahme der Videodatei.

© Blue Marble Geographics • screen & paper GmbH
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12 Global Mapper Pro
Global Mapper Pro ist eine optionale Zusatzkomponente der Software, die eine Reihe von erweiterten Funktionen 
eröffnet, darunter Werkzeuge für die LIDAR- und Punktwolkenverarbeitung, erweiterte Geländeanalyse, 
Skriptbearbeitung und Python-Skripterstellung.

Aktivieren von Global Mapper Pro
Global Mapper Pro wird mit der Standardversion von Global Mapper installiert, jedoch ist zur Aktivierung ein gülti-
ger Registrierungsschlüssel erforderlich. Dieser Schlüssel kann bei screen & paper bestellt oder zu Ihrem ursprüngli-
chen Kauf hinzugefügt werden. 

Um Global Mapper Pro zu aktivieren, verwenden Sie das Hilfemenü, um den Lizenzmanager auszuwählen. Durch 
einfaches Aktivieren des Kontrollkästchens neben Global Mapper Pro wird das Registrierungsfenster geöffnet. Nach 
Aktivierung der Lizenz steht die Global Mapper Pro-Funktionalität sofort zur Verfügung.

Erweiterte LiDAR-Daten und Punktwolken-Funktionalität
Eine Schlüsselfunktion von Global Mapper Pro besteht in den diversen Werkzeugen zur Bearbeitung von LiDAR-
Daten und Punktwolken (im folgenden Text zusammengefasst unter LiDAR): Umklassifizieren, Anwenden von 
Filtern, Extrahieren von Vektormerkmalen aus einer Punktwolke und Erstellen einer Punktwolke aus überlappenden 
Luftbildern. Global Mapper Pro verbessert die Leistung von punktwolkenbezogenen Prozessen erheblich und bietet 
mehrere Visualisierungsoptionen, einschließlich Querschnittsansicht und Bearbeitung eines Punktstreifens.

Übersicht Bearbeitung von LiDAR-Daten (von links nach rechts):

• Auswahlliste aller Visualisierungsoptionen
• Filtern nach Klassifikation und Returntype-Parametern
• LiDAR-Klassen selektieren
• LiDAR nach Entfernung auswählen
• Doppelte LiDAR-Punkte finden
• LiDAR-Daten räumlich ausdünnen
• Farbe aus Luftbildern auf LiDAR-Punkte übertragen
• LiDAR QC: Höhenkorrektur mit Kontrollpunkten
• LiDAR-Daten an eine Referenzwolke anpassen
• LiDAR-Daten vergleichen
• 3D-Modell (Mesh) aus LiDAR-Daten erstellen
• Punktwolken aus Bildern erstellen (Pixel-to-Point)

Übersicht Klassifizierungswerkzeuge (von links nach rechts)

• Entfernung von Rauschen
• Automatische Klassifizierung Boden
• Automatische Klassifizierung Gebäude und Vegetation
• Automatische Klassifizierung von Hochspannungsleitungen und Masten
• Vektorelemente automatisch extrahieren (Gebäude, Bäume, Hochspannungsleitungen und Mastpunkte)
• Segmentierungswerkzeug – identifiziert Objektsegmente basierend auf räumlichen und Attribut-Beziehungen
• LiDAR-Segmente auswählen
Manuelle Klassifizierung
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Die manuelle Klassifizierung von Punkten kann mit Schaltflächen aus einer dritten Symbolleiste in den 2D- und 
Pfadprofil-Ansichten auf ausgewählte Punkte angewendet werden.

Punktwolken auf der Basis von Fotos erstellen
Das auch »Pixel-to-Point« genannte Werkzeug verwendet photogrammetrische Methoden, um 3D-Punktwolken, 
Orthofotos und/oder fototexturierte 3D-Modelle aus überlappenden, mit Geotags versehene Bilder zu erstellen. 
Ideal geeignet für UAV- oder Drohnen-Aufnahmen, analysiert Pixel-to-Point die Beziehung zwischen erkennbaren 
Objekten in benachbarten Bildern, um die dreidimensionalen Koordinaten der entsprechenden Oberfläche zu 
bestimmen.

Um eine Punktwolke zu erstellen, klicken Sie einfach auf die Schaltfläche »Punktwolke aus Bilder (P2P)« und laden 
Ihre Bilder in das entsprechende Dialogfeld, legen die erforderlichen Einstellungen fest und fügen, falls verfügbar, 
Bodenkontrollpunkte hinzu, bevor über die Schaltfläche »Ausführen« der Prozess gestartet wird.

Der Prozess ist rechenintensiv und die 
Verarbeitung kann je nach den Eingabedaten, 
den angewendeten Qualitätseinstellungen sowie 
dem verfügbaren Speicher und den verfügbaren 
Ressourcen einige Zeit in Anspruch nehmen.
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Bild- und Geländeanalyse

Gelände-Painting

Dieses Werkzeug ermöglicht die manuelle Anpassung, Korrektur und 
Gestaltung von Geländemodellen.

Erzeugen von Bruchkanten

Automatische Bruchkantenextraktion zum Erstellen von Vektorlinien-
Elementen bei deutlichen Änderungen der Höhe/Neigung.

Raster vektorisieren

Ein Werkzeug zum Extrahieren und Glätten von Vektorbereichen aus 
Rasterbildern und Geländeebenen.

Skripting
• »Skripteditor« mit 

Syntaxfärbung zum Erstellen, 
Bearbeiten und Ausführen 
von Global Mapper- und 
Python-Skripten.

• Integration der 
Programmiersprache Python.
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13 Wo Sie Hilfe finden

Global Mapper-Hilfedokumente
Das durchsuchbare Hilfesystem von Global Mapper wird automatisch mit der Software installiert und kann über das 
Hilfemenü oder durch Klicken auf die Taste F1 aufgerufen werden. Sie können entweder durch den Inhaltsbereich 
blättern oder nach einem Stichwort suchen, um Informationen zu der jeweiligen Funktion zu finden. Eingebettete 
Hyperlinks helfen beim Navigieren zwischen Abschnitten und bieten zusätzliche Informationen zum ausgewählten 
Thema.

Online-Quellen
Eine Online-Version des vollständigen Benutzerhandbuchs ist hier verfügbar: 
https://www.bluemarblegeo.com/knowledgebase/global-mapper-22-1/GlobalMapper.htm

Aufzeichnungen der Global Mapper Webinar-Reihe, die verschiedene Themen der Software abdecken, können auf 
dem Blue Marble YouTube-Kanal angesehen werden: 
https://www.youtube.com/user/BlueMarbleWebinars

Das Global Mapper-Forum
Das Global Mapper Forum ist eine aktive Online-Community von Nutzern und Experten aus den unterschiedlichsten 
Branchen und Bereichen. Forumsteilnehmer haben die Möglichkeit, Fragen zu stellen, Tipps zu geben und sich an 
Diskussionen über den Einsatz der Software und deren Weiterentwicklung zu beteiligen. Viele neue Benutzer emp-
finden das Durchsuchen der veröffentlichten Themen als einen unschätzbaren Teil ihrer Lernerfahrung.

Ein Link zum Global Mapper Forum ist im Hilfemenü der Software verfügbar oder direkt über folgenden Link:  
https://www.globalmapperforum.com

Trainingsmöglichkeiten
Es stehen sowohl öffentliche als auch unternehmensspezifische Schulungsmöglichkeiten zur Verfügung, um Ihnen 
zu helfen, das Beste aus der Software herauszuholen. Die aktuellen Kurse und Informationen zur Anmeldung finden 
Sie hier: https://www.globalmapper.de/training

Für einzelne Unternehmen oder Organisationen können auch maßgeschneiderte Vor-Ort- oder Online-Kurse arran-
giert werden. Für Informationen per E-Mail: info@screen-paper.de

Globaler Mapper-Support
Bei Supportfragen wenden Sie sich direkt an uns oder nutzen auch ein vorkonfiguriertes Formular auf der folgenden 
Webseite: https://www.bluemarblegeo.com/forms/support.php
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14 Nützliche Tastenkombinationen

Allgemeine Anwendung
Benutzerhandbuch öffnen F1
3D-Fenster anzeigen Strg+3
Drucken Strg+P
Global Mapper beenden Alt+X

Dokumentenverwaltung
Datendatei öffnen (Import) Strg+O
Aktuellen Arbeitsbereich speichern Strg+S
Arbeitsbereich laden Strg+W
Alle Ebenen entladen (entfernen) Strg+U
Ausgewählte Elemente in die Zwischenablage kopieren Strg+C
Ausgewählte Elemente löschen und in die Zwischenablage kopieren Strg+X
Einfügen von Elementen aus der Zwischenablage in eine 
ausgewählte Ebene Strg+V
Kontrollcenter öffnen Alt+C

Werkzeugauswahl
Digitalisier-Werkzeug Alt+D
Element-Info-Werkzeug Alt+P
Messwerkzeug Alt+M
Zoom-Werkzeug Alt+Z

Zoomen und Schwenken
Hineinzoomen Seite nach unten
Rauszoomen Seite nach oben
Zoomen auf den vollen Umfang aller geladenen Daten Home
Schwenken der Karte (¼ Bildschirmschritte) Pfeiltasten
Schwenken der Karte (gesamter Bildschirm) Strg+Pfeiltasten

Digitialisier-Funktionen
Element unter dem Cursor bearbeiten Doppelklick mit der linken Maustaste
Element auswählen u. automatisch Bewegungsmodus aktivieren Alt+Linksklick
Letzten Vorgang rückgängig machen Strg+Z
Aktuellen Vorgang abbrechen Esc
Ausgewähltes Element löschen Löschen
Wiederherstellen des ausgewählten Elements Umschalt+Entf
Automatisches Snappen beim Zeichnen eines Elements 
vorübergehend deaktivieren Alt+Linksklick

Benutzerdefinierte Tastenkombinationen
Über die Dropdown-Liste Favoriten in der Symbolleiste können zusätzliche Tastenkombinationen manuell zugewie-
sen werden.
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15 Häufige Fragen

Wie registriere ich Global Mapper?
Nachdem Sie Global Mapper installiert haben, starten Sie die Software und Sie sehen das Fenster »Global Mapper 
registrieren«. Wenn Sie eine Lizenz erworben haben, geben Sie Ihre Kontoinformationen wie aufgefordert ein, um 
die volle Funktionalität freizuschalten.

Wie projiziere ich eine Ebene neu?
Öffnen Sie das Dialogfeld Konfiguration (Werkzeuge > Konfiguration), wählen Sie den Abschnitt Projektion und aktu-
alisieren Sie die Projektions- und Koordinatenparameter nach Bedarf. Diese Einstellungen werden auf alle gelade-
nen Daten und auf exportierte Ebenen angewendet.

Wie ändere ich die Hintergrundfarbe des Kartenfensters?
Klicken Sie auf das Menü Ansicht und wählen Sie »Hintergrundfarbe«. Die ausgewählte Farbe wird im aktuellen 
Arbeitsbereich gespeichert.

Wie kann ich ein gelöschtes Element wiederherstellen?
Verwenden Sie die Tastenkombination Strg+Umschalt+D, um zwischen der Anzeige und dem Ausblenden gelöschter 
Elemente umzuschalten. Wählen Sie das erforderliche Element mit dem Digitalisier-Werkzeug aus, klicken mit der 
rechten Maustaste auf die Karte und wählen »Wiederherstellen«, um das Element in seinen ursprünglichen Zustand 
zurückzusetzen. Alternativ können Sie direkt nach dem Löschen des Elements die Tastenkombination Strg+Z ver-
wenden.

Wie füge ich der Karte Text ohne begleitendes Symbol hinzu?
Wählen Sie das Werkzeug »Punkt-/Text-Element erstellen« aus der Symbolleiste Digitalisierer und klicken Sie auf 
die Position der Karte, an der Sie den Text platzieren möchten. Geben Sie im daraufhin angezeigten Dialogfeld 
»Element-Info modifizieren« den Text ein, den Sie in das Feld Name hinzufügen möchten, und wählen Sie Text aus 
der Dropdown-Liste Element-Typ aus.

Wie speichere ich Karten-Ebenen aus einer Online-Datenquelle für die Offline-
Verwendung?
Nachdem die erforderlichen Online-Daten im Kartenfenster angezeigt wurden, klicken Sie auf das Menü Datei und 
wählen Sie Exportieren > Raster-/Bildformat exportieren. Stellen Sie im Dialogfeld Exportoptionen sicher, dass die 
Einstellungen für Exportgrenzen der gewünschten Ausdehnung entsprechen. Das Belassen der Standardeinstellung 
»Alle geladenen Daten« kann zu einer extrem großen Datei führen und die Verarbeitungszeit verlängern. Schließen 
Sie nach Abschluss des Exportvorgangs die Verbindung zu den Online-Daten im Kontrollcenter und importieren Sie 
die zuvor exportierte Datei.

Wie automatisiere ich Datenverarbeitungsaufgaben in Global Mapper?
Es gibt mehrere Werkzeuge, die verwendet werden können, um bestimmte Datenverarbeitungsaufgaben zu rationa-
lisieren. Im Menü Datei kann der Befehl »Stapelverarbeitung Konvertieren/Umprojizieren« verwendet werden, um 
mehrere Dateien eines bestimmten Typs gemeinsam in ein anderes Format zu übersetzen und/oder die Daten in 
ein anderes Koordinatensystem neu zu projizieren. Scripting kann auch verwendet werden, um mehrere Aufgaben 
in einem Workflow zu automatisieren. Ein Skript ist eine einfache Textdatei, die eine Reihe von Befehlen und zuge-
hörigen Parametern zum Importieren, Verarbeiten und Exportieren von Daten enthält. Weitere Informationen zur 
Skripterstellung finden Sie auf der folgenden Webseite:  
https://www.bluemarblegeo.com/knowledgebase/global-mapper-23/Scripting_Reference/ScriptReference.html
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